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Preface

SQL*Plus Getting Started for Windows provides information about the SQL*Plus 
product that is specific to the Microsoft Windows NT 4.0, Windows 95, and 
Windows 98 operating system environments. 

Specific topics discussed in this preface are:

■ Prerequisites

■ Intended Audience

■ How This Guide Is Organized

■ Related Documents

■ Obtaining Online Help

■ Documentation and Code Conventions Explained

Notes: Refer to the READMEDOC.HTM file at the top level of the 
Oracle8i for Windows NT CD-ROM for the most up-to-date 
information on Oracle8i release 8.1.6 support for Windows 2000.

In the remainder of this guide, SQL*Plus for Windows, will be 
referred to as SQL*Plus. 
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Prerequisites
This guide assumes that you are familiar with the following:

■ SQL*Plus commands and general features. You should refer to the generic 
SQL*Plus documentation set before using this guide. See "Related Documents" 
on page ix.

■ Commands for deleting and copying files and the concepts of the search path, 
subdirectories, and path names.

■ Fundamentals of the Microsoft Windows NT or Windows 95/98 operating 
systems.

Intended Audience
This guide is for all users who want to use SQL*Plus in the Windows NT or 
Windows 95/98 operating environments.

How This Guide Is Organized
This guide is organized as follows:

Chapter 1, "Introducing SQL*Plus"

Chapter 2, "Installing SQL*Plus Help and Demonstration Tables"

Chapter 3, "Using SQL*Plus"

Chapter 4, "Operating System-Specific References"

Appendix A, "Customizing Operating System Parameters"
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Related Documents
SQL*Plus Getting Started for Windows provides information specific to SQL*Plus 
on Windows-based platforms only. For information about SQL*Plus 
cross-platform support, features, and commands, refer to the generic SQL*Plus 
documentation set on the product CD-ROM. In addition to the complete 
documentation for the Oracle Enterprise Edition for Windows product, the 
following SQL*Plus documentation is available for online viewing:

■ SQL*Plus 8.1.6 Release Bulletin (for late-breaking information not included 
in the SQL*Plus documentation)

■ SQL*Plus User’s Guide and Reference

■ SQL*Plus Quick Reference

Obtaining Online Help
Online help for using SQL*Plus is available from the SQL*Plus command line 
during a session. The SQL*Plus help tables must be created and populated by the 
database administrator first. See "Installing SQL*Plus Online Help" in Chapter 1 for 
information about installing SQL*Plus online help. 

Note: Before installing SQL*Plus, refer to the generic SQL*Plus 
documentation on the CD-ROM, and to the Release Notes and 
Readme files on the CD-ROM for late-breaking information. 
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Documentation and Code Conventions Explained
The following conventions are used in this guide.

Convention Example Meaning

All uppercase plain ALTER DATABASE Indicates command names, SQL 
reserved words, and keywords. All 
uppercase plain is also used for 
directory names and file names.

Italic ■ Italic is used to indicate a variable:

filename

■ Italic is used for emphasis:

This section describes new 
SQL*Plus features specific to 
Windows NT/95/98.

Indicates a value that you must 
provide. For example, if a command 
asks you to type filename, you must 
type the actual name of the file.

Italic is also used for emphasis in the 
text and to indicate the titles of other 
guides.

Oracle database The database component of Oracle8i.

C:\> ■ This example refers to the default 
for the first Oracle home in an 
Optimal Flexible Architecture 
(OFA)-compliant database.

C:\>ORACLE\ORA81

Represents the Windows command 
prompt of the current hard disk 
drive. Your prompt can differ and 
can, at times, reflect the subdirectory 
in which you are working. Referred 
to as the MS-DOS command prompt in 
this guide.

Backslash (\) 
before a directory 
name

\ORADATA Indicates that the directory is a 
subdirectory of the root directory.
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ORACLE_HOME and 
ORACLE_BASE

Go to the ORACLE_BASE\ORACLE_
HOME\ADMIN directory

In previous releases when you 
installed SQL*Plus, all subdirectories 
were located under a top level 
ORACLE_HOME directory, that by 
default was:

■ C:\ORANT for Windows NT

■ C:\ORAWIN95 for Windows 95

■ C:\ORAWIN98 for Windows 98

or whatever you may have called 
your Oracle home.

With this Optimal Flexible 
Architecture (OFA)-compliant 
release, all subdirectories are no 
longer under a top level ORACLE_
HOME directory. There is now a new 
top level directory called ORACLE_
BASE, which by default is 
C:\ORACLE. 

For more information about multiple 
Oracle homes and Optimal Flexible 
Architecture (OFA), see Oracle8i 
Administrator’s Guide for Windows NT.

HOME_NAME OracleHOME_NAMETNSListener Represents the Oracle home name.

The home name can be up to sixteen 
alphanumeric characters. The only 
special character allowed in a home 
name is the underscore. 

Convention Example Meaning
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Symbols period  .

comma  ,

hyphen  -

semicolon  ;

colon  :

equal sign  =

backslash  \

single quote  ‘

double quote  “

parentheses ( )

Symbols other than brackets and 
vertical bars must be entered in 
commands exactly as shown.

Convention Example Meaning
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1
Introducing SQL*Plus

This chapter provides introductory information to help you get started with 
SQL*Plus.

Specific topics discussed are:

■ Overview

■ Basic Concepts
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Overview
You can use the SQL*Plus tool with SQL (Structured Query Language) and its 
procedural language extension, PL/SQL. These database languages allow you to 
store and retrieve data in Oracle databases. PL/SQL allows you to link several SQL 
commands through procedural logic.

SQL*Plus enables you to manipulate SQL commands and PL/SQL blocks, and to 
perform many additional tasks. With SQL*Plus, you can:

■ Enter, edit, store, retrieve, and run SQL commands and PL/SQL blocks.

■ Format, perform calculations on, store, and print query results in the form of 
reports.

■ List column definitions for any table.

■ Access and copy data between databases.

■ Send messages to and accept responses from an end user.

■ Perform database administration.

SQL*Plus on Windows provides both a command line interface and a graphical user 
interface (GUI). See Chapter 3, "Using SQL*Plus" for more information.

Note: Although Server Manager is shipped with this 8.1.6 release, 
Oracle Corporation recommends that you migrate to SQL*Plus. 



Basic Concepts

Introducing SQL*Plus 1-3

Basic Concepts
The following definitions explain concepts central to SQL*Plus: 

For definitions of other concepts that are relevant to SQL*Plus, see the glossary in 
SQL*Plus User’s Guide and Reference.

Concept Definition

command An instruction you give to an operating system, or 
software such as SQL*Plus or Oracle, to perform a 
particular task. 

SQL command A command to execute SQL statements.

SQL*Plus command A command to execute SQL*Plus statements.

block In PL/SQL, a group of SQL and PL/SQL commands 
related to each other through procedural logic.

table The basic unit of storage in Oracle.

query A read only SQL SELECT command that retrieves 
information from one or more tables.

query results The data retrieved by a query. 

report Query results formatted by you through SQL*Plus 
commands.

SQL buffer A buffer which stores the last SQL command or PL/SQL 
block that you entered in SQL*Plus.

screen buffer A buffer to store the data in the SQL*Plus application 
window.
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2
Installing SQL*Plus Help and

Demonstration Tables

This chapter provides installation information to help you install SQL*Plus 
components.

Specific topics discussed are:

■ Installing SQL*Plus

■ Installing SQL*Plus Online Help

■ Accessing Demonstration Tables
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Installing SQL*Plus
The CD-ROM insert that accompanies your product CD-ROM includes the 
following information about SQL*Plus:

■ System requirements

■ Installation instructions 

Installing SQL*Plus Online Help
Online help is available from the command line of either the Graphical User 
interface or the Command Line interface while you are using SQL*Plus. The 
database administrator creates the SQL*Plus help tables and populates them with 
SQL*Plus help data.

Prerequisites
Before you can install SQL*Plus help, ensure that:

■ SQL*Plus is installed, otherwise, you cannot create and load the help tables. 

■ The default tablespace for the SYSTEM user is large enough to accommodate 
the help system. You must have at lease 128K of free disk space.

■ The SQL*Plus help script files are available in 

%ORACLE_HOME%\SQLPLUS\ADMIN\HELP\ 

The help script files are:

■ HELPBLD.SQL – to drop and create new help tables. 

■ HELPUS.SQL – to populate the help tables with the help data. 

■ HELPDROP.SQL – to drop existing SQL*Plus help tables. 

■ The Windows command file, HELPINS.BAT, is available in

%ORACLE_HOME%\BIN\ 

Note: Before installing SQL*Plus, refer to the generic SQL*Plus 
documentation on the CD-ROM, and to the Release Notes and 
Readme files on the CD-ROM for late-breaking information. 



Installing SQL*Plus Online Help

Installing SQL*Plus Help and Demonstration Tables 2-3

Installing SQL*Plus Help
To install SQL*Plus help:

Select the “Enable InterMedia demos and add SQL*Plus help tables” from the 
Database Configuration Assistant during installation.

or

1. Set an environment variable, SYSTEM_PASS, to hold the SYSTEM user login 
with:

SET SYSTEM_PASS=SYSTEM/PASSWORD

where PASSWORD is the password you have defined for the SYSTEM user.  The 
default SYSTEM user password is MANAGER. 

The HELPINS utility reads this login from SYSTEM_PASS to run successfully.

2. Run the batch file, HELPINS.BAT, from a command line prompt with:

C:\> %ORACLE_HOME%\BIN\HELPINS US

or

1. Run SQL*Plus as the SYSTEM user with:

C:\> SQLPLUS SYSTEM/PASSWORD

where PASSWORD is the password you have defined for the SYSTEM user.

2. Run the SQL script, HELPBLD.SQL, from SQL*Plus with:

SQL> @%ORACLE_HOME%/SQLPLUS/ADMIN/HELP/HELPBLD.SQL

Accessing SQL*Plus Help
To access SQL*Plus help, enter one of the following commands in SQL*Plus:

SQL> HELP
or

SQL> HELP INDEX
or

SQL> HELP TOPIC

If you know the topic for which you want help, enter the following:
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SQL> HELP topic

where topic is a SQL*Plus help topic. For example, enter 

SQL> HELP COLUMN

for help on the Column command.

If you get a response that help is unavailable, check that you have correctly installed 
SQL*Plus help in the SYSTEM schema.

For more information about the Help command, see Chapter 8, “Command 
Reference” in the SQL*Plus User’s Guide and Reference.

Accessing Demonstration Tables
To load the demonstration tables, start SQL*Plus with the user account that allows 
you to complete the exercises. SQL*Plus User’s Guide and Reference refers to the user 
name SCOTT with the password TIGER, but you can use any account with the same 
privileges.

Enter the following command at the SQL*Plus prompt:

SQL> @%ORACLE_HOME%\SQLPLUS\DEMO\DEMOBLD.SQL

When you finish working through the examples, you can remove the demonstration 
tables from the database by entering the following command:

SQL> @%ORACLE_HOME%\SQLPLUS\DEMO\DEMODROP.SQL
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3
Using SQL*Plus

This chapter explains how to start and use SQL*Plus from both the command line 
interface and the graphical user interface, and describes the menu options.

Specific topics discussed are:

■ Using the Command Line Interface

■ Using the Graphical User Interface
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Using the Command Line Interface
The SQL*Plus command line interface is standard on all operating systems.

If you are connecting to a remote Oracle database, make sure your 
Net8/networking software is installed and working properly. For more information, 
see the Net8 Administrator’s Guide and the Appendix, "Net8 Configuration", in the 
Oracle8i Administrator’s Guide for Windows NT. 

To start the SQL*Plus command line interface:

1. Select Command Prompt in the Start menu. A Command Prompt window 
appears.

2. Start SQL*Plus by entering

C:\> SQLPLUS

You can optionally include your login username and password separated by a 
slash (/), and a remote database name to connect to,  for example:

C:\> SQLPLUS username/password@net_service_name

Otherwise you will be prompted to enter your username and password. 

Interpreting Arguments in Windows
The rules for interpreting arguments in Windows command files are as follows:

■ Arguments are delimited by white space.

■ A string surrounded by double quotation marks, for example, “this string”, is 
interpreted as a single argument.
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■ A double quotation mark preceded by a backslash is interpreted as a literal 
double quotation mark.

For more information about SQL*Plus command line arguments, refer to the 
SQL*Plus User’s Guide and Reference.

Using the Graphical User Interface
While the command line interface is a standard feature of SQL*Plus on all operating 
system platforms, the graphical user interface is a feature of SQL*Plus for Windows.

If you are connecting to a remote Oracle database, make sure your 
Net8/networking software is installed and working properly. For more information, 
see Net8 Administrator’s Guide and the Appendix, "Net8 Configuration", in the 
Oracle8i Administrator’s Guide for Windows NT.

To start the SQL*Plus graphical user interface:

1. Select Programs in the Start menu. Then select Oracle - ORACLE_HOME, then 
Application Development, and click SQL Plus.

The SQL*Plus window appears displaying the Log On dialog.

Enter a valid user name and password. If you are connecting to a remote Oracle 
database, enter the Net8 net_service_name in the Host String field. See the Net8 
Administrator’s Guide for more information about configuring and using Net8 
net_service_names.

2. Click OK.

or

1. Select Command Prompt in the Start menu. A Command Prompt window 
appears.



Using the Graphical User Interface

3-4 SQL*Plus Getting Started

2. Enter

C:\> SQLPLUSW

The SQL*Plus graphical user interface starts. You can optionally include your 
login username and password separated by a slash (/), and a remote database 
name to connect to, for example:

C:\> SQLPLUSW username/password@net_service_name

Otherwise enter the required information in the login dialog as described 
above. The Oracle SQL*Plus application window appears.

Using the SQL*Plus Application Window
SQL*Plus displays the SQL command prompt in the application window.

To enter SQL and SQL*Plus commands, type each command at the SQL*Plus 
prompt and press Enter.

Using the Mouse Buttons to Copy SQL Commands in the Application Window
You can use the mouse buttons to copy previously entered SQL commands to the 
current SQL prompt.

SQL*Plus 
command 
prompt 
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To copy a command, highlight the intended command with the left mouse button. 
While still holding down the left mouse button, click the right mouse button. 
SQL*Plus copies the text to the SQL*Plus prompt.

Using the Command Keys
The following command keys have special functions in SQL*Plus:
 :

Using the SQL*Plus Menus
This section describes menus in the SQL*Plus graphical user interface (GUI). 
Bracketed entries show keyboard shortcuts to that File Menu command.

File Menu
The File menu has the following options:

Key Function

Home Top of screen buffer 

End Bottom of screen buffer

Page Up Previous screen page

Page Down Next screen page

Ctrl+Page Up Show page on left of current screen page

Ctrl+Page Down Show page on right of current screen page

Alt+F3 Find

F3 Find next

Ctrl+C Cancels an operation running in SQL*Plus.

Ctrl+C Copies text - when no operations are running in SQL*Plus.

Ctrl+V Paste text 

Shift+Del Clear the screen and the screen buffer 

Option Description of File Menu Option Command Line

Open The Open option retrieves a previously stored command file.

If you supply no file extension, SQL*Plus looks for command files with 
the .SQL extension.

GET filename
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Save The Save option has three alternatives: Save Create, Save Replace, 
and Save Append.

SAVE

■ Save Create saves the contents of the SQL*Plus buffer in a 
command file. By default, SQL*Plus assigns the .SQL extension to 
command files. You can specify a different extension in the File 
name text box.

SAVE filename 
CREATE

■ Save Replace replaces the contents of an existing file with the 
contents of the SQL*Plus buffer. If the file does not exist, SQL*Plus 
creates the file.

SAVE filename 
REPLACE

■ Save Append adds the contents of the SQL*Plus buffer to the end 
of the file you specify.

After you save a command file, you can:

■ Retrieve the file using the Open option on the File menu.

■ Edit the file using the Editor option on the Edit menu.

■ Run the file using the START or RUN commands from the 
SQL*Plus command prompt.

SAVE filename 
APPEND

Save As The Save As option saves the contents of the SQL*Plus buffer in a 
command file.

By default, SQL*Plus assigns the .SQL extension to command files. 
You can specify a different extension in the File name text box.

SAVE filename

Spool The Spool option has two alternatives: Spool File and Spool Off.

■ Spool File stores query results in a file. By default, SQL*Plus 
assigns the .LST extension to spool files. You can specify a 
different extension in the File name text box. You can edit the 
results with the Editor option on the Edit menu, and print the file 
from a Windows text editor.

SPOOL filename

■ Spool Off turns off spooling. SPOOL OFF

Run The Run option lists and executes the SQL command or PL/SQL block 
currently stored in the SQL buffer.

RUN

Cancel
(CTRL+C)

The Cancel option cancels an in-progress operation.

This keyboard shortcut is only available when a SQL*Plus operation is 
running in the SQL*Plus session. When no SQL*Plus operation is 
running, CTRL+C copies selected text.

Ctrl-C

Exit The Exit option commits all pending database changes and closes the 
SQL*Plus application window.

EXIT

Option Description of File Menu Option Command Line



Using the Graphical User Interface

Using SQL*Plus 3-7

Edit Menu
The Edit menu has the following options:

Search Menu
The Search menu has the following options:

Option Description of Edit Menu Option Command Line

Copy
(CTRL+C)

The Copy option copies selected text to the Clipboard.

After you copy text to the Clipboard, you can paste the text into other 
Windows applications, such as Microsoft Excel and Microsoft Word.

This keyboard shortcut is only available when no SQL*Plus operations 
are running in the SQL*Plus session. When a SQL*Plus operation is 
running, CTRL+C cancels the running operation.

not applicable

Paste
(CTRL+V)

The Paste option pastes the contents of the Clipboard onto the 
SQL*Plus command line.

Note: A maximum of 3625 characters can be pasted from the 
Clipboard onto the SQL*Plus command line during a single paste 
operation.

not applicable

Clear
(SHIFT+DEL)

The Clear option clears the screen of the SQL*Plus application 
window and the screen buffer.

CLEAR SCREEN

Editor The Editor option has two alternatives: Invoke Editor and Define 
Editor.

■ Invoke Editor loads the contents of the SQL*Plus buffer into an 
editor. By default, SQL*Plus saves the file to AFIEDT.BUF. You can 
specify a different file name in the editor.

EDIT

■ Define Editor defines the editor that is invoked. DEFINE_EDITOR
= editor name

Option Description of Search Menu Option Command Line

Find
(ALT+F3)

The Find option searches for a character, a word, or a group of 
characters or words in the SQL*Plus application window. Find begins 
the search at the top of the displayed screen.

Note: When Find reaches the end of the displayed screen, it does not 
wrap and continue searching from the top of the screen buffer.

not applicable

Find Next
(F3)

The Find Next option finds the next occurrence of the search text. not applicable
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Options Menu
The Options menu has the following options:

Option Description of Options Menu Option Command Line

Environment The Environment option allows you to set system variables to alter the 
SQL*Plus environment for your current session.

This dialog has three areas: Set Options, Value, and Screen Buffer.

Note: See "Setting Options and Values, Using the Environment Dialog" 
on page 3-9 for examples of how these controls interact.

Set Options

This area has a list of variables you can select to establish aspects of the 
SQL*Plus environment for your current session, such as:

■ Setting the display width for NUMBER data.

■ Setting the display width for LONG data.

■ Enabling or disabling the printing of column headings.

■ Setting the number of lines per page.

See the “Command Reference” chapter in SQL*Plus User’s Guide and 
Reference for descriptions of each system variable in the SET command.

SET variable value

Value

The Value area has four options: Default, Custom, On, and Off.

Note: When Custom is selected, the On and Off buttons and the text 
field may or may not be enabled for user selection. The availability of 
these fields depends on the item in the Set Option you selected. 

SET variable value

Screen Buffer

This area has two text boxes: Buffer Width and Buffer Length.

SET variable value

• In the Buffer Width text box, you can set the number of 
characters that SQL*Plus displays on one line. If you enter a 
number smaller than the length of output data, SQL*Plus 
truncates the data to match the buffer width you specified. The 
default value of the Buffer Width parameter is 100 characters. 
You can specify from 80 to 1000 characters on one line.

• In the Buffer Length text box, you can set the number of lines 
that SQL*Plus displays on the screen. If SQL*Plus displays more 
lines of data than you specify, the remaining lines of data will 
“wrap around” to the top of the screen buffer. The default value 
of the Buffer Length parameter is 1000 lines. You can specify 
from 100 to 2000 lines on one screen.
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Help Menu
The Help menu has the following option:

Setting Options and Values, Using the Environment Dialog
Choose Environment from the Options menu to display the Environment dialog 
which you can use to create a SQL environment statement for the current session. 

Choose an item from the Set Options list to begin. You can use the default settings, 
or you can customize the settings by using the other dialog controls. The available 
controls vary with the options you choose. You can make multiple changes to 
options and values. When the text box is available, you can enter appropriate text or 
appropriate numeric values. Click OK to commit your settings. 

Example 3–1

The arraysize is set to 15, the default value. Since the arraysize is a numeric variable, 
the On and Off buttons are not available.

Note: When you change the Screen Buffer option, SQL*Plus displays 
a dialog to alert you that if you shorten the size of your screen buffer, 
some data may not be displayed on your screen. Click OK to proceed.

Option Description of Help Menu Option Command Line

About SQL*Plus Displays the SQL*Plus version number and copyright information.

You access SQL*Plus help from the SQL*Plus prompt. See "Accessing 
SQL*Plus Help" in Chapter 1, Introducing SQL*Plus.

not applicable

Option Description of Options Menu Option Command Line

Because Default is chosen, the text box shows the default value. 
The default setting cannot be changed.

Click the Default radio button
to use the default value 

Choose one of 
these options 

Because arraysize is 
a numeric value, these 
buttons are not available
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To change the arraysize, click Custom and enter the number in the text box.

Example 3–2

The default for echo is off. To change the setting, click Custom and then click 
On. Since echo can only be on or off, the text box is not available.

 Exiting SQL*Plus
You enter EXIT or QUIT at the SQL*Plus prompt to exit SQL*Plus from the 
command line interface or from the graphical user interface (GUI).

You return to the Windows Command Prompt when you exit either the command 
line interface, or the GUI if you started it from the command line with SQLPLUSW. 

The GUI closes and you return to Windows when you exit SQL*Plus from the GUI.

Enter a custom numeric value in the text box

Click Custom to set
your own value 

The text box is not available
because echo can only be on or off 

Click Custom to set
your own value 
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4
Operating System-Specific References

This chapter provides the operating system-specific information that is referenced 
in SQL*Plus User’s Guide and Reference.

Specific topics discussed are:

■ Automatic Login

■ TIMING Command

■ Interpreting Error Messages

■ Setting Up Your SQL*Plus Environment

■ Sending Results to a File

■ @, @@, and START Commands

■ HOST Command

■ SET NEWPAGE Command

■ PRODUCT_USER_PROFILE Table
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Automatic Login
When connecting to an Oracle database on the same Windows computer, you can 
set up SQL*Plus to do an automatic login by following these steps:

1. Create an account in the database <PREFIX>USERX for every Windows user 
(USERX) who needs access to the database. <PREFIX> is the parameter OS_
AUTHENT_PREFIX in the inititialization parameter file for the database (the 
default is OPS$). See the Oracle8i Reference and the Oracle Advanced Security 
Administrator’s Guide for more information about the OS_AUTHENT_PREFIX 
initialization parameter.

2. After logging on to Windows as USERX, you can log in to SQL*Plus using  / 
(slash) instead of username/password.

See “Shortcuts to Starting SQL*Plus” in Chapter 2 of SQL*Plus User’s Guide and 
Reference which refers you to this guide for information about automatically logging 
on to SQL*Plus when you log on to your operating system.

TIMING Command
The SQL*Plus TIMING command displays output in hours, minutes, seconds and 
hundredths of seconds, for example,  02:31:07.55, which is 2 hours, 31 minutes and 
7.55 seconds. 

See “Collecting Timing Statistics on Commands You Run” in Chapter 2 and the 
sections “SET” and “TIMING” in Chapter 8 of SQL*Plus User’s Guide and Reference 
which discuss how to use the TIMING command and the SET TIMING command to 
record timing data for an elapsed period.

Interpreting Error Messages
See “Interpreting Error Messages” in Chapter 2 of the SQL*Plus User’s Guide and 
Reference and this guide for information about interpreting error messages. See 
Oracle8i Error Messages to find explanations and actions for error codes beginning 
with the letters ORA.

If you do not find the error code in Oracle8i Error Messages, see Oracle8i 
Administrator’s Guide for Windows NT.
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Setting Up Your SQL*Plus Environment
When you install SQL*Plus, LOGIN.SQL is copied to the DBS subdirectory of your 
Oracle home directory.

When you install SQL*Plus, GLOGIN.SQL is copied to the SQLPLUS\ADMIN 
subdirectory of your Oracle home directory.

If you modify LOGIN.SQL or GLOGIN.SQL, make sure you do not add any ANSI 
escape sequences.

Some Oracle products use a LOGIN file named LOGIN.NEW. If this file exists on 
your computer, make sure you do not use it with SQL*Plus.

See “Setting Up Your SQL*Plus Environment” in Chapter 3 of SQL*Plus User’s Guide 
and Reference, which describes the LOGIN.SQL and GLOGIN.SQL files.

Sending Results to a File
The SPOOL command is available from the File menu in the SQL*Plus graphical 
user interface. See "File Menu" on page 3-5 for more information.

When you use the SPOOL command from the graphical user interface or the 
command line interface, SQL*Plus adds .LST to the file name if you do not specify 
an extension.

SQL*Plus does not support the use of the SPOOL OUT clause at the command line.

See “Sending Results to a File” in Chapter 4 of SQL*Plus User’s Guide and Reference, 
which describes the SPOOL command.

@, @@, and START Commands
SQL*Plus searches the current default directory for the file name that you specify 
with the @, @@, or START command. If SQL*Plus cannot find this file, the program 
searches a path to find the file.

You can specify the path that SQL*Plus searches by modifying the SQLPATH 
parameter in your registry. For more information about the SQLPATH parameter, 
see the "SQLPATH Parameter Description" in Appendix A

See the sections “@ (at sign)”, “@@ (double at sign)”, and “START” in Chapter 8 of 
SQL*Plus User’s Guide and Reference, which describe how SQL*Plus searches for a file 
when you use the @, @@, or START command.
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HOST Command
In SQL*Plus, you can access the Windows command prompt by entering the HOST 
command or a dollar sign ($) at the SQL*Plus prompt.

To return to SQL*Plus from the Windows command prompt, enter the EXIT 
command.

See “HOST” in Chapter 8 of SQL*Plus User’s Guide and Reference, which describes 
how to use the HOST command to execute a host operating system command 
without leaving SQL*Plus.

SET NEWPAGE Command
The SET NEWPAGE 0 command does not clear the screen between pages. Instead, a 
black box appears. 

See “SET” in Chapter 8 of SQL*Plus User’s Guide and Reference, which describes how 
to set the NEWPAGE system variable, as well as many other system variables.

PRODUCT_USER_PROFILE Table
 The PUP table provides product-level security that supplements the user-level 
security provided by the SQL GRANT and REVOKE commands and user roles.

To create the PUP table

Log in to SQL*Plus as the SYSTEM user and run PUPBLD.SQL which is located 
in the ORACLE_HOME\SQLPLUS\ADMIN directory with:

 SQL> @%ORACLE_HOME%\SQLPLUS\ADMIN\PUPBLD.SQL 

or

1. Set an environment variable, SYSTEM_PASS, to hold the SYSTEM user login 
with:

C:\> SET SYSTEM_PASS=SYSTEM/PASSWORD

where PASSWORD is the password you have defined for the SYSTEM user.  The 
default SYSTEM user password is MANAGER. 

PUPBLD.BAT reads this login from SYSTEM_PASS to run successfully.

2. Run the batch file, PUPBLD.BAT, from a command line prompt with:

C:\> %ORACLE_HOME%\BIN\PUPBLD.BAT
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If you are using SQL*Plus with a remote database, you may want to install the 
PRODUCT_USER_PROFILE table on the remote database. To do this, run 
PUPBLD.SQL on the server directly. Or, you can set the LOCAL parameter in your 
registry to point to the remote database and then run PUPBLD.SQL.

See the “PRODUCT_USER_PROFILE Table” in Appendix E of the SQL*Plus User’s 
Guide and Reference for a description of the PRODUCT_USER_PROFILE (PUP) table.
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A
Customizing Operating System Parameters

This chapter describes how to customize your SQL*Plus configuration by changing 
the SQLPATH parameter in the registry.

Specific topics discussed are:

■ Using the Registry

■ SQLPLUS Environment Variable

Warning: Editing the registry may affect your application’s user 
interface. Only advanced users should edit the registry.



Using the Registry

A-2 SQL*Plus Getting Started

Using the Registry
When you install Oracle products for Windows, Oracle Universal Installer adds 
relevant parameters to the registry.

The following table indicates which registry version(s)—REGEDT32.EXE and/or 
REGEDIT.EXE—you can use for your particular Windows platform: 

The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE subkey contains the Oracle 
parameters.

See the registry’s help system for instructions on how to edit the parameters.

If you change the value of an Oracle parameter or add a parameter to the registry, 
the change will take effect whenever SQL*Plus executes a procedure that uses the 
parameter.

SQLPATH Parameter Description
This section describes the SQLPATH registry parameter used by SQL*Plus for 
Windows.

Subkey: HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0

Default Value: \ORACLE\ORA81

Valid Values: any directory on any drive

This parameter specifies the location of SQL scripts. In addition to searching the 
directory specified by the SQLPATH parameter, SQL*Plus also searches the current 
directory for SQL scripts.

When you set the SQLPATH parameter, directories can be concatenated with a 
semicolon (;). For example:

C:\ORACLE\ORA81\DATABASE;C:\ORACLE\ORA81\DBS

Windows Platform REGEDT32.EXE REGEDIT.EXE

Windows NT 4.0 YES YES

Windows 95 NO YES

Windows 98 NO YES
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SQLPLUS Environment Variable
The SQLPLUS environment variable specifies the location of SQL*Plus message 
files. This environment variable is set during installation and has a default value of 
%ORACLE_HOME%/SQLPLUS/MESG. You should not modify or set this environment 
variable. 
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Index
$ command, 4-4
@ command, 4-3
@@ command, 4-3

A
accessing sample tables, 2-4
AFIEDT.BUF, 3-7
ANSI escape sequences, warning about, 4-3
audience, SQL*Plus, viii

B
basic concepts, 1-3
block, defined, 1-3
buffer

clearing your screen, 3-7
screen, 1-3
screen area, 3-8
SQL, 1-3, 3-6

C
cancelling an in-progress operation, 3-6
CD-ROM contents, ix, 2-2
clearing your screen, 3-7
code conventions, used in this guide, x
command files

opening, 3-5
saving, 3-6

command keys, SQL*Plus GUI, 3-5
command line interface, 3-2
command, defined, 1-3
connect string, 3-3

copying text, 3-4, 3-7

D
DEMOBLD.SQL file, 2-4
DEMODROP.SQL file, 2-4
demonstration tables, 2-4
documentation

conventions used in this guide, x

E
Edit menu, 3-7
editor

defining, 3-7
invoking, 3-7

environment
setting up SQL*Plus, 3-8, 4-3

Environment command, 3-8
Environment Variable

SQLPLUS, A-3
error messages, interpreting, 4-2
exiting SQL*Plus, 3-10
exiting SQL*Plus GUI, 3-6

F
File menu, 3-5
finding text, 3-7

G
GLOGIN.SQL file, 4-3
graphical user interface
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menus, 3-5
starting, 3-3

H
help

accessing online help, 2-3
installation prerequisites, 2-2
installing, 2-2

Help menu, 3-9
HOME_NAME, defined, xi
HOST command, 4-4
host string, 3-3

I
installing

SQL*Plus online help, 2-2

L
LOCAL parameter, 4-5
Log On dialog, 3-3
LOGIN.NEW file, warning about, 4-3
LOGIN.SQL file, 4-3

M
menus

graphical user interface, 3-5
mouse, using to copy commands, 3-4
MS-DOS, accessing from SQL*Plus, 4-4
multiple Oracle homes

defined, xi

O
online help

accessing online help, 2-3
installation prerequisites, 2-2
installing, 2-2
obtaining for SQL*Plus, ix, 2-2

operating systems, supported by SQL*Plus, vii
Optimal Flexible Architecture (OFA), xi
Options menu, 3-8
ORA error messages, 4-2

ORACLE_BASE, defined, xi
ORACLE_HOME, defined, xi
overview, 1-2

P
parameter

SQLPATH, 4-3, A-2
pasting text, 3-7
PL/SQL, relation to SQL*Plus, 1-2
Prerequisites

installing online help, 2-2
prerequisites, viii
PRODUCT_USER_PROFILE table, 4-4
PUPBLD.SQL file, 4-4

Q
query results, defined, 1-3
query, defined, 1-3

R
REGEDIT.EXE, A-2
REGEDT32.EXE, A-2
registry, using, A-2
report, defined, 1-3
rules, for Windows arguments, 3-2
Run menu command

lists and executes SQL and PL/SQL, 3-6

S
sample tables, 2-4
saving, command files, 3-6
screen buffer area, 3-8
Search menu, 3-7
security

PRODUCT_USER_PROFILE table, 4-4
sending results to a file, 4-3
SET NEWPAGE command, 4-4
Set Options area, 3-8
SET TIMING command, 4-2
setting up, using LOGIN and GLOGIN, 4-3
shortcuts to starting SQL*Plus, 4-2
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SPOOL command, 4-3
spool files, 4-3
spool menu command, 3-6
SPOOL OUT clause, not supported, 4-3
SQL*Plus

application window, 3-4
basic concepts, 1-3
command defined, 1-3
command line interface, 3-2
exiting, 3-10
installing, 2-2
installing online help, 2-2
menus, 3-5
overview, 1-2
prerequisites, viii
setting up environment from command line, 4-3
setting up environment from GUI, 3-8
shortcuts to starting, 4-2
using LOGIN and GLOGIN to setup, 4-3
Windows versions supported, vii

SQLPATH parameter, 4-3, A-2
SQLPLUS Environment Variable, A-3
START command, 4-3
Start menu location, for SQL*Plus, 3-3
starting SQL*Plus, 3-2
starting SQL*Plus GUI, 3-3
subkey, registry, A-2
system requirements, 2-2
system variables, setting, 3-8

T
table, defined, 1-3
tables, sample, 2-4
text editor

defining, 3-7
invoking, 3-7

TIMING command, 4-2

V
value

screen area, 3-8
value area, 3-8

W
Windows Operating Systems

note on Windows 2000 support, vii
versions supported, vii
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